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New Features in Primavera P6 EPPM 8.4 
New features in Primavera P6 EPPM 8.4 include: 

 Integration with Primavera Prime 
 Integration with Primavera Unifier 
 Update baselines 
 Add new column in highlighted position 
 Additional search attributes when assigning resources 
 View project users 
 Submit timesheets via Team Member 
 Enhancements to Visualizer 
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Integration with Primavera Unifier 
New integration functionality enables you to export activity, resource, and expense data and then perform 
cost analysis on that data in Unifier. 
  

 
  



New Features in Primavera P6 EPPM 8.4 

 

 3

Send P6 Data to Unifier 

Enhanced integration in P6 8.4 enables cost analysis of P6 data in Unifier. 
  
Summarized duration, unit, and cost data is exported from P6 to Unifier. The type of data exported is based 
on the schedule in P6: Duration-based schedules send just duration data; resource-loaded schedules send 
duration and unit data; cost-loaded schedules send duration, unit, and cost data. 
  
Assign Cost Breakdown Structure codes to activities, resource assignments, and expenses in P6. These cost 
codes are imported into P6 from Unifier and are used to summarize P6 data in Unifier's cost sheet. 
  
When the data is exported from P6, projects are linked via Primavera Gateway: The P6 Project ID maps to a 
Project Number in Unifier. 
  
In Unifier, a summary sheet displays summary data for each project -- one for the project and one for each 
baseline, up to 12 total sheets. 
  
Use Unifier's advanced costing, cash flow, and earned value functionality to analyze P6 data. 
  
Integration between P6 and Unifier runs as a job service in the background of the application. Integration 
can be scheduled to run at a set time or on-demand. 
   

 
  
 To access this feature: 
On the Actions menu on the Activities page, click Exchange Data, Send to Primavera Unifier or Update 
from Primavera Unifier. 
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Integration with Primavera Prime 
P6 offers two areas of integration with Primavera Prime: 

 Risk management: Send P6 data to Prime for Monte Carlo risk analysis. Data from Prime is 
imported back to P6 with pessimistic date estimates for activities. 

 Scope management: In P6, add activities to work packages and then assign actual dates and 
relationships. P6 data is sent to Prime to update work package dates and costs. 

Release 14.2 of Prime adds scope management and risk management functionality. Future modules will 
create a fully integrated modular solution. 
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Send P6 Project Data to Prime for Risk Analysis 

P6 8.4 enables you to perform quantitative risk analysis in Primavera Prime to assess the potential impact on 
a project's cost and schedule. To run a risk analysis in Prime, project data must be imported from P6. Ensure 
that prerequisites for running a risk analysis are satisfied in P6: establish activity and risk data; create 
response plan details; enter uncertainty estimates for project activities; and schedule the project. Risk data 
includes risk thresholds, risk scoring matrices, and mapping risks to activities.  
  
Three new fields are added in P6 8.4 to record uncertainty estimates for activities: Minimum Duration, 
Maximum Duration, and Most Likely Duration. Data entered in these fields is referenced by Prime's Monte 
Carlo simulation when running risk analysis. The fields can be updated for task dependent or resource 
dependent activities only. 
  
After satisfying prerequisites for Prime risk analysis, specify the Prime workspace to which the P6 project 
will be moved via a new column on the EPS page. After a Prime Workspace project code is assigned, send 
the data to Prime to create, update, or run a risk analysis on the project. P6 sends data to Prime for all 
projects on the Activities page. Sending data to Prime runs as a job service in P6. 
   

 
 
To access this feature: 
On the Actions menu on the Activities page, click Exchange Data, Send to Primavera Prime.  
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Update P6 Project with Risk Analysis Output from Prime 

After running a risk analysis in Primavera Prime, data can be sent back to P6 to view pessimistic date 
estimates for activities. The following risk outputs are added to P6 as columns on the Activities page: Pre 
Response Pessimistic Start, Pre Response Pessimistic Finish, Post Response Pessimistic Start, Post 
Response Pessimistic Finish. These fields are read-only and can be changed by importing updated data from 
Prime. Two Gantt chart bars have been added in P6 to incorporate the data in the pessimistic date columns: 
Pre Response Bar and Post Response Bar. These bars can be added to the Activities page Gantt chart for 
each activity with pessimistic date data. 
  
Import pessimistic date data in P6 by running the Update from Primavera Prime job service. P6 will attempt 
update all projects on the Activities page with corresponding Prime data. This service runs in the 
background of P6, allowing you to continue using the application. Monitor a service's progress in the View 
Service Status dialog box. 
  

 
 
To access this feature: 
On the Actions menu on the Activities page, click Exchange Data, Update from Primavera Prime. 
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Scope Management 

The integration between P6 and Prime allows you to manage the costs and schedules of scope items at the 
activity level.  
  
Scope items are materials used in an activity. In Prime, scope items are assigned to work packages. Work 
packages are sent to P6 as leaf-level WBS nodes.  
  
In P6, add activities to work packages to provide a greater level of detail to the project. A work package is a 
bucket of short-term work used to manage installation of related scope items. Activity data created in P6 can 
be sent back to Prime to update work package dates and costs. 
  
Projects integrated between P6 and Prime are indicated in a new column, Integrated Project, on the EPS 
page in P6. WBS nodes that were created from work packages in Prime are indicated by an icon on the 
Activities page in. The WBS structure for integrated projects is locked in P6. If the work package structure 
in Prime changes, update the P6 project with the new structure by using the Update from Primavera Prime 
function. 
   

 
  
To access this feature: 
On the Actions menu on the Activities page, click Exchange Data, Send to Primavera Prime or Update from 
Primavera Prime. 
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Usability 
Key usability enhancements in P6 include: 

 Update baselines. 
 Add new column in highlighted position. 
 Additional search attributes when assigning resources. 
 Multi-select when assigning users and security profiles. 
 Select multiple values in reports. 
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Update Baselines 

P6 8.4 provides the ability to update project baselines. Use this feature if there have been significant 
changes to a project and an updated baseline is required. In previous versions, this was done by deleting a 
baseline and then defining a new one. The Update Baseline feature allows you to selectively update some or 
all of a baseline's details while retaining the past performance of activities against the original baseline. Add 
new activities to a baseline but still retain comparison data for existing activities. Filter activities that are 
updated and those that remain unchanged. 
  
The Update Baseline feature in P6 8.4 provides greater control over a baseline's details without affecting 
application performance. The feature runs as a job service, allowing you to continue working while the 
baseline updates in the background. Monitor a service's progress in the View Service Status dialog box; you 
will receive a notification when the service is complete. Update Baseline cannot run as a scheduled service. 
  

 
  
To access this feature: 
Click Define Baselines on the Actions menu on the EPS or Activities Page. In the Baselines dialog box, 
select a baseline and click the Update Baseline icon. 
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Add New Column in Highlighted Position 

P6 8.4 allows you to add a new column to a precise location in the Customize Columns dialog box. 
Previously, any column added to the Selected Columns field was added to the end of the list. Add an 
Available Column directly beneath a Selected Column by highlighting it first. This saves time when adding 
multiple columns in a specific order. 
  

 
  
To access this feature: 
Open any Customize Columns dialog box in P6 8.4. 
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Additional Search Attributes When Assigning Resources 

P6 8.4 includes additional options for searching and assigning resources: Resource ID, Resource Name, 
Primary Role, E-mail, Office Phone, or Location. The application displays a list of resources that satisfies 
the search criteria. Resource details for a selected resource are shown on the right side of the Select 
Resource dialog box.  
   

 
  
To access this feature: 
Open Select Resource dialog box on the Activities page in the Projects section, or the Assignments page in 
the Resources section. 
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Reassign Relationships by Activity ID 

P6 8.4 allows you to reassign relationships to activities by changing the Activity ID. Previously, changing a 
relationship required the deletion of an existing assignment and selection of a new one. Now, select the 
Activity ID field in a relationship detail window and then type a new Activity ID to reassign the activity. 
Values in the Relationship Type and Lag fields entered for the previous assignment will not change when 
assigning a new activity. 
  

 
  
To access this feature: 
On the Activities page, select an Activity ID in the Predecessors, Successors, or Relationships detail 
window. Enter a new Activity ID or click the ellipsis to select an activity. 
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View Service Status on EPS Page 

The Service Status dialog box is added to the Actions menu on the EPS page in P6 8.4. The dialog box 
displays services that can be run from the EPS page, including Summarize Projects, Publish Projects, and 
Update Baseline. Scheduled services do not display in the dialog box.  
   

 
  
To access this feature: 
On the Actions menu on the EPS page, click View Service Status. 
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View Project Users 

P6 8.4 allows you to view users working in a specific project. A Users button has been added to the Open 
Projects dialog box, which enables you to view users logged into a project and e-mail one or all of the users. 
  

 
  
To access this feature: 
Select one or more Available Projects in the Open Projects dialog box. Click Users. 
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Expand All/Collapse All on Users Page 

Use Expand All or Collapse All in P6 8.4 to view the full list of users in User Access Settings. The option is 
available only when users are grouped by Global Security Profile or User Interface View. 
  

 
  
To access this feature: 
Click User Access on the Administer menu and then open the Users page. 
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Assign Multiple Responsible Managers to a User 

P6 8.4 allows you to assign multiple Responsible Manager positions to one user simultaneously. In the 
Select Responsible Manager dialog box, select OBS nodes. The user will become the Responsible Manager 
of projects assigned to those nodes.  
  

 
  
To access this feature: 
Open the User Access page on the Administer menu. On the Project Access tab of the Users page, click 
Add. 
  



New Features in Primavera P6 EPPM 8.4 

 

 17

Select a Project Security Profile When Assigning Users to an OBS 

In previous versions of P6, the default project security profile would be automatically assigned to a user 
when assigning him to an OBS -- a process that could take considerable time depending on the number of 
users and profiles being assigned. In P6 8.4, select a project security profile in the Select Users dialog box 
and assign one or more users to an OBS. The default project security profile is the default option in the 
Select Users dialog box. 
  

 
  
To access this feature: 
Open the User Access page on the Administer menu. On the Users tab of the OBS page, click Assign User. 
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Assign Multiple Users to Multiple OBS Nodes Simultaneously 

P6 8.4 allows the assignment of one or more users to one or more OBS nodes at the same time, reducing the 
overall time spent assigning users to OBS nodes. Select one or more OBS Names on the OBS page and 
choose one or more users to assign in the Select Users dialog box. You can choose a Project Security Profile 
to assign to all selected users. 
  

 
  
To access this feature: 
Open the User Access page on the Administer menu. On the Users tab of the OBS page, click Assign User. 
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Select Multiple Values in Report Settings 

P6 8.4 provides the option to select multiple values for a parameter in the Reports Settings dialog box. 
Before running a report, select the list of parameters. Fields that previously presented values in single-select 
lists are now presented in multi-select check boxes, allowing you to select multiple, all, or none of the 
values for a field. 
  

 
  
To access this feature: 
Click the Reports tab. Right-click a report and select Run Report to open the Report Settings dialog box. 
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Team Member 
Enhancements in P6 Team Member 8.4 include: 

 Submit timesheets 
 Enhanced sorting 
 Updating notebooks 
 New method for current period units 
 Status other resources 
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Timesheets View 

The new Timesheets view in Team Member 8.4 enables you to update work on tasks and submit timesheets 
for approval. This functionality was previously included in P6 Progress Reporter. 
  

 
  

 In the Actions menu, add tasks to timesheets, assign resources to tasks, add overhead time, edit a 
subordinate's timesheets, and generate reports. 
 

 Add date- and time-stamped notes for your timesheet approval manager. 
   

 View timesheets listing all the tasks to which you are assigned during a specified time period. Select 
other time periods to update other tasks. 
  

 View additional details for each task, status task by Time Left or Percent Complete, contribute to a 
discussion, and mark a task complete. 
  

 Enter regular and overtime hours for each task. 
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Updating Current Period Units 

Previous versions of Team Member required you to manually add progress to a task. For example, if you 
needed to add 5 hours to a task with 10 hours already worked, you would select 15 hours. This method 
required manual calculations that reduced efficiency, especially when updating many tasks.  
  
In Team Member 8.4, simply add the amount of time worked since your last update. To add 5 hours to 10 
hours already spent, select 5 hours. Team Member 8.4 automatically reflects your cumulative time as 15 
hours spent on a task. In Team Member Mobile, you can update tasks from your mobile device. 
  

 
 
To access this feature: 
In the Details panel of the My Tasks View, update the field Log Additional Time. 
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Application Settings 

The new Application Settings tab in Team Member 8.4 enables you to change how timesheets are used and 
the data they display: 

 Specify the number of timesheets and search results you can access.  
 Determine privileges for editing timesheets and activities that have not started or are already 

finished.  
 Control the number of hours a resource can enter for each day or reporting period.  

To access Application Settings, you must have the Edit Application Settings global privilege enabled in P6. 
  

 
  
To access this feature: 
Click the Application Settings tab from any page in Team Member. 
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Setting Preferences 

In Team Member 8.4, Preferences is expanded to allow you to customize your profile and format settings. 
Update office phone number, e-mail address, or login password, choose how dates are displayed, and select 
the format for units and durations. 
  

 
 
To access this feature: 
Click the User list in Team Member and select Preferences. 
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Statusing Other Resources 

Team Member 8.4 allows the primary resource, activity owner, or a user with a Team Member distribution 
filter to update the details of labor, non-labor, and material resources assigned to the task. Fields that can be 
updated are set in the Project Preferences dialog box in P6. 
  

 
  
To access this feature: 
In the Details panel of the My Tasks View, click Status Other Resources. 
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Enhanced Sorting 

Team Member 8.4 offers additional options when sorting tasks: 

 Task ID 
 Task Name 
 Project ID 
 Project Name  
 Start Date 
 Finish Date (default) 

Click the icon next to the Sort By list to choose the sorting order, ascending or descending. 
  

 
  
To access this feature: 
In the My Tasks View, click the Sort By list. 
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Updating Notebooks 

Team Member 8.4 allows you to edit notebook details from the My Tasks view. Click Notebooks below a 
task to view a list of notebooks associated with the task. Formatting options include font size, color, 
highlighting, text alignment, and numbering. You can preview changes before applying them to the 
notebook. This feature is only available to users who have the Team members can update notebooks option 
checked in the Project Preferences dialog box in P6 8.4. 
 

 
 
To access this feature: 
In the My Tasks View, click the Notebooks link below a task. 
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Filtering by Resource 

The Resource Filter in Team Member 8.4 enables you to display tasks by primary resource. The Resource 
list contains all resources that are assigned as a primary resource for the tasks displayed in the My Tasks 
View. 
  

 
  
To access this feature: 
In the My Tasks View, click the arrow in the Resources list. 
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Attach Photos to Tasks in Team Member Mobile 

Team Member Mobile enables you to attach a photo to a task by capturing a new photo or choosing an 
existing one. This feature is useful when the best way to communicate an issue with your team is with an 
image. To attach a photo, you must be connected to a P6 server that has a content repository configured. 
After the photo is attached, you and team members can view it in the task's documents. 
  

 
  
To access this feature: 
In Team Member Mobile, select a task and tap the camera icon to attach a photo or send a photo in an e-
mail. 
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P6 Professional 
Enhancements in P6 Professional 8.4 include: 

 Integration with Primavera Prime and Primavera Unifier 
 New Visualizer functionality 
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Visualizer Enhancements 

New Visualizer functionality enables you to add legends to your headers and footers, add shifts as date 
intervals, copy chart bar settings, and manage multiple layouts at the same time. 
  

 
  



New Features in Primavera P6 EPPM 8.4 

 

 32 

Shift as a Date Interval 

In P6 Professional 8.4, Visualizer allows you to display shifts on a Gantt chart or timescale logic diagram. 
Choose Shift as a Date Interval on any of the three timescales in the Timescale tab, and then choose a shift 
in the Shift Calendar list. Common shift calendars include one- or three-shift operations. Shifts are managed 
in the Resource Shifts dialog box of P6 Professional.  
  

 
  
To access this feature: 
On the Timescale tab in Visualizer, select Shift from the Date Interval list. 
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Include Legend in Header or Footer 

In P6 Professional 8.4, insert a legend into the header or footer of a Visualizer chart. Customize the font and 
alignment; add images, tables and variables; and add, delete, or resize sections. Variables for the legend 
include dates, bars, activity codes, and lines. A separate set of variables can be selected for legends in the 
header and footer. 
  

 
  
To access this feature: 
In the Page Setup tab in Visualizer, open the Title Block tab. 
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Manage Multiple Layouts Simultaneously 

In P6 Professional 8.4, Visualizer enables you to select one or more layouts in the Manage Layouts dialog 
box. Paste layouts from one grouping to another, move a selection of layouts to the Global layout grouping 
band (for User or Project layouts), or move a selection of layouts to the Project layout grouping band (for 
User layouts only).  
 

 
  
To access this feature: 
Open the Manage Layouts dialog box in Visualizer. 
  



New Features in Primavera P6 EPPM 8.4 

 

 35

Copy Bar Settings 

In P6 Professional 8.4 Visualizer, copy an existing bar to create layouts quicker and simpler. Copy existing 
bars and then modify them to create new bar definitions. 
  

 
  
To access this feature: 
Open the Bars & Labels tab in Visualizer. In the Available Bars section, click Copy. 
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Manage Baselines as Job Services 

In P6 Professional 8.4, the add, copy, and update baseline functions now run as job services, enabling you to 
work while the processes run in the background of the application. You will receive a notification after a 
service is completed. This functionality is not available if P6 Professional is a standalone install. 
  

 
  
To access this feature:    
On the Project menu, click Maintain Baselines. In the Maintain Baselines dialog box, click Add, Copy, or 
Update. 
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Import XML as a Job Service 

In P6 Professional 8.4, importing projects in XML format is performed as a job service. Projects imported in 
Primavera P6 XML or Microsoft Project XML formats run as a scheduled job, allowing you to continue 
working in the application while the file is importing. You will receive a notification after the import is 
completed. This functionality is not available if P6 Professional is a standalone install. 
  

 
  
To access this feature: 
On the File menu, click Import. 
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Integration with Primavera Unifier 

Enhanced integration in P6 Professional 8.4 enables cost analysis of P6 data in Unifier. 
  
Summarized duration, unit, and cost data is exported from P6 Professional to Unifier. The type of data 
exported is based on the schedule in P6 Professional: Duration-based schedules send just duration data; 
resource-loaded schedules send duration and unit data; cost-loaded schedules send duration, unit, and cost 
data. 
  
Assign Cost Breakdown Structure codes to activities, resource assignments, and expenses in P6 
Professional. These cost codes are imported into P6 Professional from Unifier and are used to summarize P6 
Professional data in Unifier's cost sheet. 
  
When the data is exported from P6 Professional, projects are linked via Primavera Gateway: The P6 
Professional Project ID maps to a Project Number in Unifier. 
  
In Unifier, a summary sheet displays summary data for each project -- one for the project and one for each 
baseline, up to 12 total sheets. 
  
Use Unifier's advanced costing, cash flow, and earned value functionality to analyze P6 Professional data. 
  
Integration between P6 Professional and Unifier will run as a job service in the background of the 
application. Integration can be scheduled to run at a set time or on-demand. Integration with Unifier requires 
P6 Professional to be connected to a P6 EPPM database. 
   

 
To access this feature: 
On the File menu, click Exchange Data, Send to Primavera Prime or Update from Primavera Prime.  
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Integration with Primavera Prime 

A P6 Professional environment that is connected to an EPPM database integrated with Primavera Prime can 
exchange data for risk analysis and scope management. 
  
To run a risk analysis in Prime, project data must be imported from an integrated EPPM database. Ensure 
that the prerequisites for running a risk analysis are satisfied: establish activity and risk data; create response 
plan details; enter uncertainty estimates for project activities; and schedule the project. Risk data includes 
risk thresholds, risk scoring matrices, and mapping risks to activities. All risk data and uncertainty estimates 
must be entered in P6 Web interface. After running the risk analysis in Prime, the Update from Primavera 
Prime process updates pre- and post-response pessimistic dates for activities. This data is stored in the 
database and is not visible in P6 Professional. 
  
Scope management integration allows you to manage the costs and schedules of scope items at the activity 
level. Scope items are materials used in an activity; a work package is a bucket of short-term work used to 
manage installation of related scope items. In Prime, scope items are assigned to work packages. Work 
packages are sent to P6 Professional as leaf-level WBS nodes. In P6 Professional, add activities to work 
packages to provide a greater level of detail to the project. Activity data created in P6 Professional can be 
sent back to Prime to update work package dates and costs. 
  

 
  
To access this feature: 
On the File menu, click Exchange Data, Send to Primavera Prime or Update from Primavera Prime. 


